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				Introduction

				The only thing standing between you and your writing is your word processor. Yeah, I know: It’s supposed to be helpful. Well, it tries. Computers can do only so much. But you, as a smart person, are capable of so much more. I’m guessing that’s why you’ve opened this book.

				Welcome to Word 2010 For Dummies, which takes the pain from using Microsoft’s latest, greatest, most confusing word processing software ever! This book is your friendly, informative, and entertaining guide to the newfangled way of processing words that is Word 2010.

				Be warned: I’m not out to make you love Word. I don’t even want you to enjoy the program. Use it, yes. Tolerate it, of course. The only promise I’m offering is that this book helps ease the pain that everyone feels from using Microsoft Word at the dawn of the 21st century. Along the way, I kick Word in the butt and you will, I hope, enjoy reading about it.

				About This Book

				I don’t intend for you to read this book from cover to cover. It’s not a novel, and if it were, it would be a political space opera with an antihero and a princess fighting elected officials who are in cahoots with a galactic urban renewal development corporation. The ending would be extremely satisfying, but it would be a long novel because I need something to balance out Atlas Shrugged on my bookshelf. Anyway.

				This book is a reference. Each chapter covers a specific topic or task that Word does. Within a chapter, you find self-contained sections, each of which describes how to perform a specific task or get something done. Sample sections you encounter in this book include

				Save your stuff

				Moving a block of text

				Check your spelling

				How to format a paragraph

				Putting text into a table

				Inserting clip art

				Mail merge, ho!

				I give you no keys to memorize, no secret codes, no tricks, no videos to sleep through, and no wall charts. Instead, each section explains a topic as though it’s the first thing you read in this book. Nothing is assumed, and everything is cross-referenced. Technical terms and topics, when they come up, are neatly shoved to the side, where you can easily avoid reading them. The idea here isn’t for you to learn anything. This book’s philosophy is to help you look it up, figure it out, and get back to work.

				How to Use This Book

				You hold in your hands an active book. The topics between this book’s yellow-and-black covers are all geared toward getting things done in Word 2010. Because nothing is assumed, all you need to do is find the topic that interests you and read.

				Word uses the mouse and keyboard to get things done.

				This is a keyboard shortcut:

				Ctrl+P

				This shortcut means that you should press and hold the Ctrl (control) key and type the letter P, just as you would press Shift+P to create a capital P. Sometimes, you must press more than two keys at the same time:

				Ctrl+Shift+T

				In this line, you press Ctrl and Shift together and then press the T key. Release all three keys.

				Commands in Word 2010 exist as command buttons on the Ribbon interface. This book may refer to the tab, the command group, and then the button itself to help you locate that command button — for example, the Page Color button in the Page Background group on the Page Layout tab. Or, I might write, “the Page Color button found in the Page Layout tab’s Page Background group.”

				Menu commands are listed like this:

				TableInsert Table

				This command tells you to choose from the Table menu the command named Insert Table. The Table menu appears as a button on the Ribbon.

				The main menu in Word 2010 is the File tab menu. It replaces the File menu from older versions of Word, and the Office Button menu, found in Microsoft Office 2007. Clicking the File tab displays the File tab menu, which fills the entire Word window. To return to Word, click the File tab menu again or press the Esc key.

				When I describe a message or something you see onscreen, it looks like this:

				Why should I bother to love Glenda when robots will

				eventually destroy the human race?

				If you need further help in operating your computer I can recommend my book PCs For Dummies. It contains lots of useful information to supplement what you find in this book.

				Foolish Assumptions

				Though this book was written with the beginner in mind, I still make a few assumptions. Foremost, I assume that you’re a human being, though you might also be an alien from another planet. If so, welcome to Earth. When you conquer our planet, please do Idaho last. Thanks.

				Another foolish assumption I make is that you use Windows as the computer’s operating system, either Windows Vista or Windows 7 or any other version of Windows that can run Word 2010. Word and Windows have no specific issues as far as this book is concerned, but keep in mind that this book isn’t about Windows.

				Your word processor is Microsoft Word 2010. It is not Microsoft Works. It is not an earlier version of Word. It is not WordPerfect. It is not a version of Word that runs on a Macintosh.

				Throughout this book, I use the term Word to refer to the Microsoft Word program. The program may also be called Word 2010 or even Microsoft Office Word 2010. It’s all Word as far as this book is concerned. Word 2010 is a part of the Microsoft Office 2010 suite of programs. This book doesn’t cover any other part of Microsoft Office, though I mention Excel and Outlook wherever they encroach upon Word’s turf.

				How This Book Is Organized

				This book contains six major parts, each of which is divided into two or more chapters. The chapters themselves have been sliced into smaller, modular sections. You can pick up the book and read any section without necessarily knowing what has already been covered in the rest of the book. Start anywhere.

				Here’s a breakdown of the parts and what you can find in them:

				Part I: Your Introduction to Word

				This part provides a quick introduction to Word and word processing. You can find information on how to start and quit Word and a simple overview of the typical word processing day.

				Part II: Your Basic Word

				The chapters in this part of the book cover the seven basic tasks of any word processor: move around a document, edit text, search and replace, work with blocks of text, proof documents, save and open, and, finally, publish. (Publishing has replaced printing as the final result of your word processing efforts, though printing is still covered as part of the whole publishing milieu.)

				Part III: Formatting

				This part deals with formatting, from the smallest iota of text to formatting commands that span an entire document and more. Formatting is the art of making your document look less ugly.

				Part IV: Spruce Up a Dull Document

				This part is formatting dessert, or tasks you can do beyond regular formatting to help make your document look like more than a typical, boring document. Part IV covers lines, borders, tables, columns, lists, graphical goodness, and all sorts of stuff that makes Word more than a typical word processor.

				Part V: Even More Word

				This part covers a few dangling details that I consider myself fortunate to write about, such as outlining, collaboration, mail merge, label-making, and other interesting things that Word does.

				Part VI: The Part of Tens

				The traditional last part of any For Dummies book contains chapters with lists of ten items. You’ll find lots of helpful information there, some weird things you may not know about, plus even more useful tips, tricks, and good suggestions.

				What’s Not Here

				Word is one heck of a program. Covering the entire thing would fill a book several thousand pages long. (I kid you not.) My approach in this book is to cover as much basic word processing as possible. Because of that, some advanced features got pushed off the table of contents.

				I give you some information about macros, though it’s not meaty. Covering macros without a technical description is difficult. If the publisher ever lets me increase this book’s size to more than 400 pages, I’d be happy to add a macro chapter; the publisher’s address is in this book’s front matter, in case you want to lobby on my behalf.

				Some of the more esoteric features are touched on lightly here. For example, I could spend about 70 pages detailing what can be done with graphics in Word, but I limited myself to only a dozen pages.

				Finally, this book doesn’t cover using Word to make a blog post, create a Web page, or how to use Word as your e-mail program.Word does those things, but I consider this a word processing book rather than a Word-does-everything book.

				Icons Used in This Book

				[image: tip.eps] This icon flags useful, helpful tips or shortcuts.

				[image: remember.eps] This icon marks a friendly reminder to do something.

				[image: warning_bomb.eps] This icon marks a friendly reminder not to do something.

				[image: technicalstuff.eps] This icon alerts you to overly nerdy information and technical discussions of the topic at hand. The information is optional reading, but it may enhance your reputation at cocktail parties if you repeat it.

				Where to Go from Here

				Start reading! Observe the table of contents and find something that interests you. Or, look up your puzzle in the index.

				If you’ve been using an older version of Word, you’re probably somewhat surprised at the look of Word 2010. Therefore, I recommend that you start reading at Chapter 1.

				Read! Write! Let your brilliance shine!

				My e-mail address is dgookin@wambooli.com. Yes, that’s my real address. I reply to all e-mail I receive, and you’ll get a quick reply if you keep your question short and specific to this book or to Word itself. Although I enjoy saying “Hi,” I cannot answer technical support questions or help you troubleshoot your computer. Thanks for understanding.

				You can also visit my Web page for more information or as a diversion: www.wambooli.com.

				Enjoy this book. And enjoy Word. Or at least tolerate it.

			

		

	
		
			
				Part I

				Your Introduction to Word
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				In this part . . .

				Word processing may seem routine these days, but that hasn’t always been the case. Being able to dance your fingers across a computer keyboard and have your prose lit up by teensy dots of light on a screen is, well, sort of magic. It most certainly beats the pants off using a typewriter. For me, it’s better than trying to communicate using my nearly illegible handwriting. Routine or not, word processing is a blessing.

				Historically speaking, word processing is the culmination of an evolution that began 10,000 years ago, when the first humans started scrawling those “Look what I killed! Aren’t I cool?” cave paintings. Today, you can communicate these simple messages with technological power unrivaled in human history. This part of the book introduces you to that technology.

			

			
		

	
		
			
				Chapter 1

				Hello, Word!

				In This Chapter

				Starting Word

				Deciphering the Word screen

				Quitting Word

				Setting Word aside

				You can’t do squat with a computer until you start the thing. Likewise, you can’t even write the word squat on a computer until you start a word processing program. Because you bought this book and not Pencils For Dummies, the program you need to start is Microsoft Word. This chapter tells you how to get Word started and begin your word processing day. Let me also mention that reading this chapter is a far more enriching experience than reading Pencils For Dummies, which is barely a pamphlet, albeit one that’s charmingly illustrated.

				Getting Word Started

				There is no single way to start Word. The Windows operating system is all about offering many different (and, often, confusing) ways to get things done. Rather than bore you by listing all those ways, I figure you just want to find the best way to start Word for how you use the computer. This section offers three solid choices.

				Before you can use Word, your computer must be on and toasty. Log in to Windows. Start your computer day. (But — seriously — don’t put bread into your computer and expect toast to appear.)

				Make sure you’re seated, with a nice, upright, firm posture as you use your computer. They tell me that your wrists should be even with your elbows and that you shouldn’t have to tilt your head forward. Shoulders are back and relaxed.

				Don’t freak out because you’re using a computer. You are in charge! Keep that in mind. Chant silently to yourself, over and over: “I am the master.”

				[image: tip.eps] If you need help starting your computer, refer to my book PCs For Dummies for quick and accurate turning-on-the-computer instructions.

				You can stop chanting “I am the master” now.

				The good, yet unimaginative, way to start Word

				Without fail, the place to start any program in Windows is at the fabled Start button. It may not be the fastest or the most interesting or most convenient way to start a program, but it’s consistent and reliable — both good qualities to have in a computer. Obey these steps:

				 1. Click the Start button.

				 Use your computer mouse to click the Start button, which is often found on the left side of the taskbar and at the bottom of the screen, adorned with the Windows logo.

				 Clicking the Start button displays the Start menu.

				 2. Choose Microsoft Word 2010 from the list of programs.

				[image: 487723-ma001.tif] As luck may have it, you might find the Microsoft Word 2010 program icon (shown in the margin) right there on the Start menu. Click the icon to run the program. Otherwise, keep plowing away in Step 3.

				 3. Choose All Programs to pop up the All Programs menu and choose Microsoft Word 2010.

				 If you don’t see the Microsoft Word 2010 icon or program name, you must obey Step 4, which is almost certain to work.

				 4. Choose the Microsoft Office item (submenu) to display its contents, and then choose Microsoft Word 2010.

				Behold! Word starts! Watch in amazement as the program unfurls its sails on your computer’s monitor.

				Don’t let Word’s appearance overwhelm you! I describe what you’re looking at in the section “Looking at Word,” later in this chapter.

				If you can’t find Word anywhere on the All Programs menu, it may not be installed on your computer. This book is specific to Microsoft Word, not the Microsoft Works word processor or any other word processor. (See the section “Foolish Assumptions” in this book’s Introduction.)

				Supposedly, every program ever installed on your computer has installed its icon in a spot somewhere on the All Programs menu.

				I refer to the program as Word, though its icon may be labeled Microsoft Word, Microsoft Office Word, Microsoft Word 2010, or another variation.

				The better way to start Word

				When you use Word a lot, it helps to have quick access to its program icon; opening that icon is the way you start Word and then start your work. A better way than keeping Word hidden on the All Programs menu is to create a Word shortcut icon on the desktop. Heed these steps:

				 1. Locate the Word icon on the Start button’s All Programs menu.

				 Don’t start Word now! Just point the mouse at the Word icon on the Start button’s All Programs menu or wherever else it may be found. (Refer to the preceding section.)

				2. Right-click the Microsoft Word 2010 menu item.

				 A pop-up menu appears.

				 3. Choose Send ToDesktop (Create Shortcut).

				 4. Press the Esc key to hide the Start button menu and view the desktop.

				[image: 487723-ma002.tif] You haven’t changed anything, but you have added the Word program icon to the desktop (shown in the margin). You can use that icon to start Word: Just double-click the icon and Word starts.

				The best way to start Word

				The best way to start Word, and the way I do it every day, is to place the Word icon on the taskbar in Windows 7, or what’s called the Quick Launch toolbar in older versions of Windows. To do so, follow these steps:

				 1. Find the Word icon on the Start button’s All Programs menu.

				 Don’t click the icon — just find it!

				 2. Right-click the Word icon on the All Programs menu.

				 3a. In Windows 7, choose the command Pin to Taskbar.

				 3b. In Windows Vista, choose the command Add to Quick Launch.

				 The Word icon is pinned (permanently added to) the taskbar in Windows 7; in Windows Vista, the Word icon is slapped on the Quick Launch Toolbar.

				To start Word, you merely click the Word icon placed on the taskbar. Click! And then Word starts. That’s the fastest and bestest way to begin your word processing day.

				[image: tip.eps] Another way to have the Word icon always handy is to pin it to the Start menu directly. In Step 3, choose the item named Pin to Start Menu. That way, the Word icon always appears at the top of the list on the Start button menu.

				Start Word by opening a document

				You use the Word program to create documents, which are stored on your computer in much the same way as people pile junk into boxes and store them in their garages. But that’s not important. What is important is that you can use those documents to start Word: Opening a Word document causes Word to start and to display that document for editing, printing, or just giving others the impression that you’re doing something.

				What’s your point, Dan?

				[image: 487723-ma003.tif] My point is that you can also start Word by opening a Word document. Simply locate the Word document icon (shown in the margin) in a folder window. Double-click to open that document and Word starts up on the screen, instantly (more or less) displaying that document for editing, reading, modifying, perusing, cussing, mangling, and potentially fouling up beyond all recognition.

				The Word document you open can be on the desktop, in the My Documents or Documents folder, or in any other folder or location where a Word document icon can lurk.

				The document name appears beneath or to the right of the icon. You can use the name to determine the document’s contents — as long as the document was properly named when it was saved to disk. (More on that elsewhere in this book.)

				[image: tip.eps] In Windows 7, you can see a Jump List of recently opened documents by either right-clicking the Word icon on the taskbar or clicking the right-pointing arrow next to the Word icon on the Start button menu. Choose a document from the list to start Word and open that document.

				Word is capable of opening other types of documents, including documents from previous versions of Word, Rich Text Format documents, and others. Each of these documents has its own icon, though the icon looks similar to the standard Word document icon. See Chapter 24 for more information on opening alien documents in Word.

				Looking at Word

				Like all programs in Windows, Word offers its visage in a program window. It’s the electronic version of a blank sheet of paper — and more. It’s the more part that you might find daunting. The dee-dads and goo-bobs that surround the Word program window all have specific names that you need to know to get the most from the program. Figure 1-1 shows the big picture.

				
					Figure 1-1: Word’s visage.

				

				[image: 487723 fg0101.eps]

				Figure 1-2 highlights the gizmos at the top of the Word window, showcasing the Ribbon interface.

				
					Figure 1-2: The Ribbon.

				

				[image: 487723 fg0102.eps]

				The details of how all the dee-dads and goo-bobs in the Word window work are covered elsewhere in this book. Use this book’s index to help you find topics you might be curious about.

				The very first time you start Word, you may be asked some questions: Enter your name and initials, set up Word security, and set Microsoft update options. I recommend the updates.

				[image: tip.eps] To get the most from Word’s window, change the window size: As with any window, you can use the mouse to drag the window’s edges in or out or click the window’s Maximize button (the middle button in the window’s upper right corner) to have the window fill the screen.

				Word’s window size affects what you see in the Ribbon command groups. When the Word window is smaller, fewer buttons show up, or they may show up in three rows. When the window is larger, you see more buttons, usually in two rows.

				Around the Word window

				Word processing is about writing, so the things you see in the Word window are all there for your writing pleasure. Or, if you find writing a pain, the items festooning the Word window are there for your agony. The word for the whole of those items is interface, which is how a computer program presents itself to the human world.

				The largest portion of the Word screen is for composing text. It’s blank and white, just like a fresh sheet of paper. (Refer to Figure 1-1.) That’s where you compose and format your text, and I cover that area specifically in the next section.

				Surrounding the text-composing area is a host of goobers that are as bewildering as an exhibit in a modern art museum, as intimidating as the cockpit of a jet fighter, and almost as dangerous as a plate of sushi. Despite their intimidating presence, those items exist to help you write. The following list gives you a quick top-to-bottom explanation. Use Figure 1-1 for reference. And, please: Do not memorize anything!

				The title bar lists the document’s title, or merely Document1 until you give the document a title by saving it to disk. (See Chapter 8 for information on saving documents — very important!)

				The File tab replaces the traditional File menu of older Windows programs. Clicking the File tab replaces the contents of the Word window with a full-screen menu full of commands and their descriptions. To return to the Word window, click the File tab or any other tab on the Ribbon. Speaking of which:

				The Ribbon contains all Word commands, which appear as buttons, input boxes, and menus. The Ribbon is divided into tabs (refer to Figure 1-2). The commands on the Ribbon are separated into groups. Some tabs may appear and disappear depending on what you’re doing in Word. And the commands in groups change as you change the window’s size.

				The Ruler may or may not be visible. When it’s visible, it helps you set margins and tabs. The View Ruler button (refer to Figure 1-1) shows and hides the Ruler.

				Below the writing area dwells the status bar. This informative strip of graphical goodness contains trivial information about your document as well as the following ornaments:

				Document information lists optional data that’s specific to your document.

				The View buttons specify how the blank page appears in the window (also refer to the next section).

				The Zoom thing specifies how large or small your document appears inside the window. (See Chapter 29 for more information on zooming.)

				Don’t fret over these things! What’s important now is that you recognize the names so that you don’t get lost later.

				[image: tip.eps] You can hide the Ribbon if you would rather have more room to write: Use the Expand the Ribbon button (refer to Figure 1-2).

				The Windows taskbar, located at the bottom of the screen, is a part of Windows itself and not Word. However, as you open documents in Word, buttons representing those documents appear on the Windows taskbar.

				[image: technicalstuff.eps] Unlike in previous versions of Word, the tabs, groups, and command buttons cannot be changed. You can customize the Quick Access Toolbar (refer to Figure 1-1), and you can add your own, custom groups and tabs, a topic I cover in Chapter 29.

				The blank place where you write

				Word’s equivalent of the mind-numbing, writer’s-block-inducing blank page can be found in the center part of the Word program window (refer to Figure 1-1). That’s where the text you write, edit, and format appears. Unlike with a sheet of paper, however, the text you create in Word can be viewed in five different ways.

				Relax. Of all the different ways to view text in Word, only these two are useful enough to describe here:

				[image: 487723-ma004.tif]Print Layout: Word’s native mode is named Print Layout, shown in Figure 1-1. In this view, the entire page of text is displayed on the screen just as it prints. Print Layout view shows graphical images, columns, and all sorts of other fancy effects. You even see the blank space between pages, described as the ethereal void in Figure 1-1.

				[image: 487723-ma005.tif]Draft: I prefer using Word in Draft view, which shows only basic text and not all the fancy features. Because Draft view doesn’t show any fancy formatting (graphics, columns, or page breaks, for example), you can more easily concentrate on writing.

				The three other ways to view your document are Full Screen Reading, Web Layout, and Outline. None of these views has anything to do with basic word processing.

				Switch between views by using the View buttons found in the lower right corner of the Word program window (refer to Figure 1-1). Clicking a button with the mouse changes the view.

				When you’re working in Draft view and you want to edit a header or insert a picture, Print Layout view is activated. You can switch back to Drafts view by clicking the Drafts button when you’re done going graphical.

				One thing that’s visible in Draft view that you don’t find in Print Layout view is a thick, horizontal bar on the left side of the page, just below a document’s last line of text. That heavy bar marks the end of your document’s text.

				Draft view may also be referred to as Normal view, as it was in previous versions of Word.

				Any weird stuff you see onscreen (a ¶, for example) is a Word secret symbol. Chapter 2 tells you why you may want to view those secret symbols and how to hide them if they annoy you.

				The mouse pointer in Word

				Though word processing is a keyboard thing, you’ll find that the computer mouse does come in handy. You use the mouse to choose commands, move around the document you’re editing, and do something called selecting text. This book explains all those topics elsewhere. For now, it helps to understand how the mouse pointer changes its look as you work in Word:

				[image: 487723-ma006.tif] For editing text, the mouse pointer becomes the I-beam.

				[image: 487723-ma007.tif] For choosing items, the standard 11 o’clock mouse pointer is used.

				[image: 487723-ma008.tif] For selecting lines of text, a 1 o’clock mouse pointer is used.

				The mouse pointer may change its look when click-and-type mode is active: Lines appear to the left and right of, and below, the I-beam mouse pointer. Refer to Chapter 32 for more information on using click-and-type.

				[image: tip.eps] You can use the mouse to see what some of the little buttons and items with pictures on them do in Word. Just hover the mouse pointer over the button, and — voilà! — it’s like Folgers instant information crystals.

				Chapter 4 discusses how to use the mouse pointer to move around a document to edit different parts of your text.


				Cajoling Word to help you

				Like most programs in Windows, a Help system is available in Word. You can summon it by pressing the F1 key, which displays the Word Help window. There you can type a topic, a command name, or even a question into the box to search for help. Or, you can browse the table of contents for helpful information.

				The F1 key also works any time you’re deep in the bowels of Word and doing something specific. The Help information that’s displayed tends to be specific to whatever you’re doing in Word. Little buttons that look like question marks in blue circles also summon Word Help.

				Though it’s nice to have the help available, the information offered is little more than the “Word manual,” which is as cryptic and unforgiving as the computer manuals that were once printed on paper.



				Ending Your Word Processing Day

				It’s the pinnacle of etiquette to know when and how to excuse oneself. Leaving can be done well or poorly. For example, the phrase “Well, I must be off,” works lots better than “Something more interesting must be happening somewhere else” — especially at Thanksgiving.

				Just as there are many ways to start Word, there are several ways to quit. You can quit the program outright, you can pause and start over, or you can set Word aside. These options are covered in the following sections.

				To quit Word

				When you’re done word processing and you don’t expect to return to it anytime soon, you can quit the Word program. Quitting a computer program is like putting away a book on a shelf. In the electronic world of the computer, this is how you do such a thing:

				 1. Click the File tab.

				 The Word screen is replaced by the File tab menu screen. Do not be alarmed.

				 2. Choose the Exit command.

				 Word vanishes from the screen.

				The only time Word doesn’t vanish is during that shameful circumstance when you have unsaved documents. If so, you’re prompted to save the document, as shown in Figure 1-3. My advice is to click the Save button to save your work.

				
					Figure 1-3: Better click that Save button!

				

				[image: 487723 fg0103.eps]

				If you click the Don’t Save button, your work isn’t saved, Word quits. If you click the Cancel button, Word doesn’t quit and you can continue working.

				See Chapter 8 for more information on saving documents.

				Also see Chapter 8 on how to recover drafts of documents you failed to save.

				You don’t have to quit Word just to start editing another document. Refer to the next couple of sections for helpful, time-saving information!

				After quitting Word, you can continue to use Windows, by starting up any other program, such as Spider Solitaire, or perhaps something more calming, such as Call Of Duty.

				Quit what you’re doing without quitting Word

				You don’t always have to quit Word. For example, if you’re merely stopping work on one document to work on another, quitting Word is a waste of time. Instead, you can close the document.

				To close a document in Word, click the File tab and choose the Close command. Word banishes the document from its window, but then the program sits there and waits for you to do something else, such as start working on a new document or open a document you previously saved.

				Bottom line: There’s no point is quitting Word when all you want to do is start editing a new document.

				When you try to close a document before it has been saved, Word displays a warning dialog box. Click the Save button to save your document. If you want to continue editing, click the Cancel button and get back to work.

				[image: remember.eps] There’s no need to close a document, really. In fact, I work on a document over a period of days and keep it open (and my PC turned on) the entire time. Doesn’t hurt a thing. (I occasionally save it to disk, which is important.)

				See Chapter 8 for more information about starting a new document.

				The keyboard shortcut for the Close command is Ctrl+W. That command may seem weird, but it’s used to close documents in many programs.

				Set Word aside

				There’s no need to quit Word if you know that you will use it again soon. In fact, I’ve been known to keep Word open and running on my computer for weeks at a time. The secret is to use the Minimize button.

				[image: 487723-ma009.tif] Clicking the Minimize button shrinks the Word window to the taskbar, where it exists as a button. With the Word program window out of the way, you can do other things with your computer. Then, when you’re ready to word-process again, click the Word button on the taskbar to restore the Word window to the screen.

				The Minimize button is the first of the three buttons in the window’s upper right corner. Refer to Figure 1-1.

			

		

	
		
			
				Chapter 2

				The Typing Chapter

				In This Chapter

				Knowing the PC keyboard

				Typing tips

				Using the spacebar

				Using the Enter key

				Backspacing and deleting

				Observing the status bar

				Minding the space between pages

				Seeing stuff in your text that isn’t there

				Living with weird underlines and colored text

				Word processing is about using the computer keyboard. It’s typing. That’s the way computers were used for years, long before the mouse and all the fancy graphics became popular. Yep, ask a grizzled old-timer and you’ll hear tales of ugly text screens and keyboard commands that would tie your fingers in knots. Though things aren’t that bad today, I highly recommend that you bone up on using your computer’s keyboard to get the most from your word processing duties. This chapter tells you what you need to know.

				Behold the PC Keyboard!

				Typing happens on a computer keyboard. Though I’m sure you can easily recognize a computer keyboard, you should know how to refer to the various keys. To assist you, I’ve illustrated a typical, generic computer keyboard in Figure 2-1.

				
					Figure 2-1: Famous attractions on the typical PC keyboard.

				

				[image: 487723-fg0201.eps]

				Here’s a summary of what you see:

				Function keys: Labeled F1 through F12 and used alone or in cahoots with the Ctrl, Alt, and Shift keys.

				Typewriter keys: The standard alphanumeric keys that the computer inherited from the ancient typewriter: a through z and the number keys plus symbols and other exotic characters.

				Cursor keys: Also called arrow keys; they control the cursor. Also included are the non-arrow keys: Home, End, PgUp (or Page Up), PgDn (or Page Down), Insert, and Delete.

				Mon key: A cute little primate that you don’t want to have as a pet.

				Numeric keypad: Keys that serve sometimes as cursor keys and sometimes as number keys. The split personality is evident on each key cap, which displays two symbols. The Num Lock key and its corresponding light are on if the numeric keypad (1, 2, 3) is active. If the cursor keys (arrows, Home) are active, Num Lock is off.

				Modifier keys: Don’t do anything by themselves. Instead, the Shift, Ctrl, and Alt keys work in combination with other keys.

				Here are some individual keys worth noting:

				Enter: Marked with the word Enter and sometimes a cryptic, left-arrow thing: ;. You use this key to end a paragraph of text.

				Esc: The “escape” key doesn’t exactly do anything in Word. However, pressing the Esc key in a dialog box is the same as clicking the Cancel button with the mouse.

				Spacebar: The only key with no symbol; inserts spaces between the words.

				Tab: Inserts the tab “character,” which shoves the next text you type over to the next tab stop; an interesting and potentially frustrating formatting key (and nicely covered in Chapter 12).

				Backspace: Your backing-up-and-erasing key — very handy.

				Delete: Also labeled Del; works like Backspace but doesn’t back up to erase. Read more on that in Chapter 4.

				Every character key you press on the keyboard produces a character on the screen, on the blank part where you write. Typing those character keys over and over is how you write text on a word processor.

				The Shift key is used to produce capital letters; otherwise, the text you see is in lowercase.

				[image: tip.eps] The Caps Lock key lets you type text in UPPERCASE letters. After you press Caps Lock, the Caps Lock light on your keyboard comes on, indicating that you’re entering ALL CAPS mode. Press the Caps Lock key again to return to normal.

				Ctrl is pronounced “control.” The variety of names that people give to the Ctrl key before they know it as the control key is amazing.

				The Old Hunt-and-Peck

				After starting Word, you’ll most likely type these words next:

				Clackity-clack-clack-clack.

				The text you type on the keyboard appears on the screen — even the typos and mistakes and bad grammar: It all falls into place regardless of your intent, posture, or good looks. This section offers some basic typing tips, suggestions, and advice.


				Depressing the keys

				You don’t actually depress a key on a computer keyboard. Nope. Instead, you press and release. Any swift tapping motion will do. Some keyboards even generate a pleasing click sound when a key is pressed.

				Now, if you really want to depress a key, just stare at it and say, “You’re one ugly, good-for-nothing key!” If that doesn’t work, continue the insults. Eventually, any well-adjusted key will succumb to your verbal taunts and find itself sufficiently depressed.



[image: tip.eps]

				“Do I need to learn to type?”

				No one needs to learn to type to use a word processor, but you do yourself a favor when you learn. My advice is to get a computer program that teaches you to type. I can recommend the Mavis Beacon Teaches Typing program, even though I don’t get any money from her and none of her children resembles me. I just like the name Mavis, I suppose.

				Knowing how to type makes a painful experience like using Word a wee bit more enjoyable.



				Follow the blinking cursor

				The key to writing in Word is to look for the insertion pointer in your text. It’s a flashing vertical bar:

				|

				Text you type appears before the insertion pointer, one character at a time. After a character appears, the insertion pointer hops to the right, making room for more text.

				For example, type this line:

				Let’s go see the clowns!

				The insertion pointer moves to the right, marching along as you type. It’s called insertion pointer for a reason: Press the left-arrow key a few times to move the insertion pointer back before the word go.

				Type the word not and a space. The word (and the space) is inserted into your text. The text to the right is pushed off to make room for the new text. Now the sentence should read:

				Let’s not go see the clowns!

				Chapter 4 covers moving the insertion pointer around in more detail.

				When to whack the spacebar

				The spacebar isn’t the same thing as the right-arrow key on the keyboard. Pressing the spacebar doesn’t just move the insertion pointer; it inserts a space character into the text. Spaces are important between words and sentences. Withoutthemreadingwouldbedifficult.

				The most important thing to remember about the spacebar is that you need to whack it only once. In word processing, as in all typing done on a computer, only one space appears between words and after punctuation. That’s it!

				I’m serious! If you’re an old-timer, you’re probably used to putting two spaces after a period, which is what they once taught in typing class. This extra space is wrong on a computer; typing it doesn’t really add more space between words or sentences. Trust me on that.

				Anytime you feel like using two or more spaces, what you need is a tab. Tabs are best for indenting text as well as for lining up text in columns. See Chapter 12 for more information.

				[image: technicalstuff.eps] The reason that only one space is needed between sentences is that computers use proportionally spaced type. Old-fashioned typewriters used monospace type, so pressing the spacebar twice after a sentence was supposed to aid in readability (though it’s debatable). Computer type is more like professionally typeset material, and both typesetters and professional-document folk now put only one space after a period or a colon.

				[image: tip.eps] If you want to type two spaces after a period and actually see them, choose a monospace font, such as Courier.

				Backup and erase keys

				When you make a typo or another type of typing error, press the Backspace key on the keyboard. The Backspace key is used to back up and erase. The Delete key can also be used to erase text, though it gobbles up characters to the right of the insertion pointer.

				Refer to Chapter 4 for more information on deleting text with Backspace and Delete.

				The Backspace key is named Backspace on your keyboard, or it may have a long, left-pointing arrow on it: ←.

				[image: remember.eps] Backspace backs up and erases. If you merely want to move the insertion pointer to the left, press the left-arrow key. See Chapter 3.

				When to press that Enter key

				In word processing, you press the Enter key only when you reach the end of a paragraph. Though pressing Enter at the end of a line of text might seem logical, there is no need: Word takes the text that hangs over at the end of a line and wraps that text down to the next line. Therefore, you press Enter only to end a paragraph.

				To practice pressing the Enter key at the end of a paragraph, type the following text:

				It was the scratching at the front door that alerted us.

				For a second I thought it might be Jasper, showing up

				late. It wasn’t. You see, around these parts, during the

				full moon, we have an issue: The dead won’t stay buried.

				Still, it was a good stew, so we decided to finish eating

				before getting busy with the axes and shovels.

				Now that you’re done typing the paragraph, press the Enter key. There. You did it right.

				There’s no need to use the Enter key when you want to double-space your text. Double-spacing uses a text formatting command in Word. See Chapter 11 for more information.

				Neither do you need to press the Enter key twice to add extra space between your paragraphs. Word can automatically add space before or after paragraphs, which is also covered in Chapter 11.

				If you want to indent a paragraph, press the Tab key after pressing Enter. This can also be done automatically; refer to (you guessed it) Chapter 11.

				[image: technicalstuff.eps] The process of taking text from the end of one line and placing it at the start of the next line is named word wrap.


				Curse you, StickyKeys!

				As your mind wanders, your fingers absently press and release the Shift key. Suddenly, you see the warning: StickyKeys! By pressing the Shift, Ctrl, or Alt key five times in a row, you activate the Windows StickyKeys function, a tool designed to make a computer keyboard more accessible to people. If you don’t need the help, you’ll probably find the intrusion annoying.

				Don’t panic! You can easily turn off the StickyKeys feature: Open the Windows Control Panel and choose the Ease of Access link. On the next screen, find and click the link labeled Change How Your Keyboard Works. Remove the check mark by Turn On Sticky Keys. Click OK and you’ll never be bothered again!



				Stuff That Happens While You Type

				As you madly compose your text, fingers energetically jabbing the buttons on the keyboard, you may notice a few things happening on the screen. You might see spots. You might see lines and boxes. You may even see lightning! All are side effects of typing in Word. They’re normal, and they’re explained in this section.

				The left end of the status bar

				The reason it’s the status bar is that it can show you the status of your document, lively updating the information as you type, as shown in Figure 2-2.

				
					Figure 2-2: Stuff that lurks on the status bar.

				

				[image: 487723-fg0202.eps]

				The type of information that’s displayed, as well as how much information is displayed, depends on how you configured Word. Chapter 29 explains which features the status bar can display.

				The status bar also displays information when you initially open a document, giving the document’s name and character count. The info disappears quickly, however.

				When a document is saved, the status bar displays information about the save, though often the information disappears too fast to see.

				Between the pages

				Word tries its best to show you where one page ends and another page begins. This feature is most helpful because often times you want to keep elements on one page, or maybe folks just like to know when the text they’re writing flows from one page to the next.

				The status bar helps you discover which page you’re working on. For example, the Page Number indicator changes from 6 to 7 when you start a new page. Word also shows you graphically where one page ends and another begins.

				In Print Layout view, you see virtual pages and a space between them, as shown in Figure 2-3.

				
					Figure 2-3: Page break in Print Layout view.

				

				[image: 487723-fg0203.tif]

				In Draft mode, the visual break between pages is shown as a faint line of dots, like ants marching across the page:

				[image: 487723-un0201.tif]

				Text appearing above the line of dots is on one page, and text below it is on the next page.

				Refer to Chapter 1 for more information on Print Layout and Draft views.

				[image: 487723-ma010.tif]You can change the gap between pages in Print Layout view. Point the mouse at the gap. When the mouse pointer changes, as shown in the margin, double-click to either close or open the gap.

				[image: technicalstuff.eps] Because the page break is, technically, a soft page break, one page is full of text and Word must start putting text on a new page. See Chapter 13 for information on forcing page breaks and other types of page breaks in Word.

				Spots and clutter in your text

				There’s no cause for alarm if you see spots — or dots — amid the text you type, such as

				This•can•be•very•annoying.¶

				What you’re seeing are nonprinting characters. Word uses various symbols to represent things you normally don’t see: spaces, tabs, the Enter key, and more.

				[image: 487723-ma011.tif] To turn these items on or off, click the Show/Hide button on the Home tab in the Paragraph group. Click once to show the goobers; click again to hide them.

				Why bother? Sometimes it’s useful to see the marks to check out what’s up with formatting, find stray tabs visually, or locate missing paragraphs, for example. (WordPerfect users: It’s as close as you can get to the Reveal Codes command in Word.)

				Strange underlines and colored text

				Adding underlining to your text in Word is cinchy; Chapter 10 tells you all about that character format. Yet sometimes Word may do some underlining and add strange-colored text on its own. 

				Red zigzag: Spelling errors in Word are underlined with red zigzags. See Chapter 7.

				Green zigzag: Grammatical errors in Word are underlined with green zigzags. See Chapter 7.

				Blue zigzag: Word-choice errors are grammatical errors, but Word flags them with a special blue zigzag regardless. The blue underlined word is most likely not the best word to use given the sentence structure. Again, see Chapter 7.

				Purple dots: Word’s Smart Tags feature uses purple dots to highlight information such as names, dates, places, and similar data that can be shared with other programs in Microsoft Office. Smart tags are briefly discussed in Chapter 32.

				Blue underlines: Word courteously highlights Web page addresses using blue, underlined text in your document. You can Ctrl+click the blue underline text to visit the Web page.

				Red underlines and strikethrough: The red text that appears either underlined or in strikethrough means that you’re using Word’s Track Changes feature. It can drive you nuts when you don’t know what’s going on, so see Chapter 26 to keep your sanity.

			

			
		

	
		
			
				Part II

				Your Basic Word

				
				[image: 487723-pp0201.eps]
			

				In this part . . .

				Word is a massive program, almost too huge to comprehend. If you try, your head will explode. I don’t recommend it.

				You’ll find that, in all of Word’s bulk, you need to use only the bare minimum for the typical, basic word processing chore. I’d estimate that the typical user never takes advantage of 90 percent of what the Word program can do. That’s okay. You’ll find that the 10 percent that remains is truly the most useful part, your basic Word. That’s the topic for this part of the book.

			

			
		

	
		
			
				Chapter 3

				To and Fro in a Document

				In This Chapter

				Using the scroll bars

				Moving the insertion pointer

				Getting around with keyboard shortcuts

				Navigating with the browse buttons

				Getting lost and getting back

				Using the Go To command

				I like the word fro. I like the word yon. They’re archaic in the English lan  guage, referring to a direction and a location, respectively. Fro doesn’t make sense by itself, so it’s used in the phrase to and fro, which refers to going somewhere and then back again. Yon is often seen with its friends hither and thither, meaning “here” and “there.” In that context, yon is a place beyond there (wherever there is). It’s also short for yonder, which is another cool word that few people use any more.

				As you work in Word, you find yourself moving to and fro and hither, thither, and yon. That’s because writing text isn’t always a linear task. You need to move that little insertion pointer guy around the document. It’s basic movement. It’s the topic of this chapter.

				Scroll Through a Document

				It’s ironic that the word scroll is used to refer to an electronic document. The scroll was the first form of recorded text, existing long before bound books. On a computer, scrolling is the process by which you view a little bit of big document in a tiny window. This section explains how scrolling is relevant in Word.

				Using the vertical scroll bar

				On the right side of the Word program window you find the vertical scroll bar, illustrated in Figure 3-1. Its operation is similar to the scroll bar in any Windows program:

				
					Figure 3-1: The vertical scroll bar.

				

				[image: 487723 fg0301.eps]

				Click the up- or down-arrow buttons at the top and bottom of the vertical scroll bar to scroll your document up or down. The document scrolls one line of text for each time you click those up- or down-arrow buttons.

				An elevator button appears inside the scroll bar. You can drag this button with the mouse, up or down, to scroll the document.

				You can click above or below the elevator button to scroll up or down one screen of text at a time.

				The elevator button’s size reflects how much of your document you can see at a time. When the button doesn’t show up, or is dimmed, the whole document appears onscreen. Otherwise, the elevator button becomes smaller as your document grows longer.

				The elevator button’s position also helps show you which part of your document is visible. When the elevator button is at the top of the scroll bar, you’re viewing text near the start of the document. When the elevator button is toward the bottom of the scroll bar, you’re seeing text near the document’s end.

				Special bonuses are involved when you drag the elevator button to scroll through your document. As you drag the button up or down, you see a page number displayed, as shown in Figure 3-2. When a document is formatted with heading styles, you also see the heading title below the page number.

				
					Figure 3-2: Scroll bar page-number info.

				

				[image: 487723 fg0302.tif]

				Scrolling through your document doesn’t move the insertion pointer. If you start typing, don’t be surprised when Word jumps back to where the insertion pointer lurks. (Refer to the later section “Commanding the insertion pointer with the mouse” for help if such a thing bugs you.)

				[image: remember.eps] Scrolling a document doesn’t move the insertion pointer!

				Refer to the section “The Browse Buttons,” later in this chapter, for information on using the browse buttons, which are located below the vertical scroll bar.

				Using the horizontal scroll bar

				The horizontal scroll bar appears just above the status bar at the bottom of the Word window — but only when your document is wider than the window. When that happens, you can use the horizontal scroll bar to shift the page back and forth and left and right.

				[image: tip.eps] When the horizontal (left-right) shifting bugs you, consider using Word’s Zoom tool to adjust the size of your document on the screen. See Chapter 29.

				Scrolling your document with the mouse

				Aside from manipulating the scroll bars, you can use your computer mouse to scurry and scamper about your document. Sadly, this suggestions works only when you have one of those wheel mice. Coincidentally, you do all these tricks by manipulating that unique wheel button:

				Roll the wheel up or down to scroll your document up or down.

				Press and hold the wheel button to activate scrolling mode. With the wheel button down, you can move the mouse up or down to pan your document in that direction.

				If the mouse’s wheel button also tilts from side to side, you can use it to pan left and right.

				Move the Insertion Pointer

				The beauty of the word processor is that you can edit any part of your document; you don’t always have to work at “the end.” The key to pulling off that trick is to know how to move the insertion pointer to the exact spot you want.

				Moving the insertion pointer is important! Scientific studies have shown that merely looking at the computer screen does no good. As hard as you wish, new text appears only at the insertion pointer. And, the text you edit or delete? Yup, the insertion pointer’s location is important there as well. Obviously, knowing how to move the insertion pointer is a big deal.

				Commanding the insertion pointer with the mouse

				The easiest way to put the insertion pointer exactly where you want it is to point the mouse at that spot in your text and then click the mouse button. Point, click, move insertion pointer. Simple.

				Moving in small increments (basic arrow keys)

				For short hops, nothing beats using the keyboard’s arrow keys to quickly move the insertion pointer around a document. The four basic arrow keys move the insertion pointer up, down, right, and left:

				
					
						
								
								Press This Key

							
								
								To Move the Insertion Pointer

							
						

						
								
								↑

							
								
								Up to the preceding line of text

							
						

						
								
								↓

							
								
								Down to the next line of text

							
						

						
								
								→

							
								
								Right to the next character

							
						

						
								
								←

							
								
								Left to the preceding character

							
						

					
				

				[image: remember.eps] Moving the cursor doesn’t erase characters. See Chapter 4 for information on deleting stuff.

				If you press and hold the Ctrl (Control) key and then press an arrow key, you enter Jump mode. The invigorated insertion pointer leaps desperately in all four directions:

				
					
						
								
								Press This Key Combo

							
								
								To Move the Insertion Pointer

							
						

						
								
								Ctrl+↑

							
								
								Up to the start of the previous paragraph

							
						

						
								
								Ctrl+↓

							
								
								Down to the start of the next paragraph

							
						

						
								
								Ctrl+→

							
								
								Right to the start (first letter) of the next word

							
						

						
								
								Ctrl+←

							
								
								Left to the start (first letter) of the previous word

							
						

					
				

				[image: warning_bomb.eps] You can use either set of arrow keys on the computer keyboard, but when using the numeric keypad, ensure that the Num Lock light is off. Do this by pressing the Num Lock key. If you don’t, you see numbers in your text rather than the insertion pointer dancing all over — like444this.

				Moving from beginning to end

				The insertion pointer also bows to pressure from those cursor keys without arrows on them. The first couple consists of End and Home, which move the insertion pointer to the start or end of something, depending on how End and Home are used:

				
					
						
								
								Press This Key or Combination

							
								
								To Whisk the Insertion Pointer 

							
						

						
								
								End

							
								
								To the end of a line of text

							
						

						
								
								Home

							
								
								To the start of a line of text

							
						

						
								
								Ctrl+End

							
								
								To the end of the document

							
						

						
								
								Ctrl+Home

							
								
								To the tippy-top of the document

							
						

					
				

				The remaining cursor keys are the Page Up or PgUp key and the Page Down or PgDn key. As you would guess, using these keys doesn’t move up or down a page in your document. Nope. Instead, they slide through your document one screen at a time. Here’s the round-up:

				
					
						
								
								Press This Key or Combination

							
								
								To Whisk the Insertion Pointer 

							
						

						
								
								PgUp

							
								
								Up one screen or to the tippy-top of your document, if you happen to be near it

							
						

						
								
								PgDn

							
								
								Down one screen or to the end of the document, if you happen to be near it

							
						

						
								
								Ctrl+Alt+PgUp

							
								
								To the top of the current screen

							
						

						
								
								Ctrl+Alt+PgDn

							
								
								To the bottom of the current screen

							
						

					
				

				[image: remember.eps] The key combinations to move to the top or bottom of the current screen are Ctrl+Alt+PgUp and Ctrl+Alt+PgDn. That’s Ctrl+Alt, not just the Ctrl key. And yes, few people use those commands.

				You may be tempted to use Ctrl+PgUp and Ctrl+PgDn, but don’t: Those commands don’t work as you would expect. Refer to the following section for the details.

				The Browse Buttons

				Lurking at the bottom of the vertical scroll bar are three buttons, as shown in the margin. These browse buttons allow you to scroll through your document in leaps and bounds of various sizes.

				[image: 487723-ma012.tif] The top button is the Browse Up button, which is linked to the Ctrl+PgUp key combination.

				[image: 487723-ma013.tif] The bottom button is the Browse Down button, which is linked to the Ctrl+PgDn key combination.

				[image: 487723-ma014.tif] The center button is the What-the-heck-am-I-browsing-for? button, which is linked to the Ctrl+Alt+Home key combination.

				When you click the center button, a pop-up palette of items to browse for appears, as shown in Figure 3-3. Pointing the mouse at any one of the items displays text that explains the item in the bottom part of the palette.

				
					Figure 3-3: Things to browse for.

				

				[image: 487723 fg0303.tif]

				Unless you’ve chosen another item from the browsing palette (refer to Figure 3-3), the browse buttons (and Ctrl+PgUp and Ctrl+PgDn) leap through your document by full pages.

				Whenever an option other than Page is chosen from the browsing palette, the browse buttons change color. So, when the buttons are black, you know that you’re browsing by page. When the browse buttons turn blue, they’re searching for something else. (Alas, the browsing palette doesn’t tell you which option is chosen.)

				Get Back to Where You Once Edited

				Considering all the various commands for moving the insertion pointer, it’s quite possible to make a mistake and not know where you are in a document. Yea, verily, the insertion pointer has gone where no insertion pointer has gone before.

				[image: tip.eps] Rather than click your heels together three times and try to get back the wishful way, just remember this keyboard combination:

				Shift+F5

				Pressing the Shift+F5 keys forces Word to return you to the last spot you edited. You can do this as many as three times before the cycle repeats. But the first time should get you back to where you were before you got lost.

				The Shift+F5 command is the same as the Browse by Edits option, found on the Browse palette. Refer to the preceding section.

				Sadly, the Shift+F5 keyboard shortcut works only in Word; you can’t use this command in real life.

				Go to Wherever with the Go To Command

				Word’s Go To command allows you to send the insertion pointer to a specific page or line or to the location of a number of interesting elements that Word can potentially cram into your document. The Go To command is your word processing teleporter to anywhere.

				To use the Go To command, click the Find button in the Home tab’s editing group. Choose the Go To command from the menu. Or, you can use the Ctrl+G keyboard shortcut. Either way, the Go To tab portion of the Find and Replace dialog box appears, as shown in Figure 3-4.

				
					Figure 3-4: Telling Word to Go To you-know-where.

				

				[image: 487723 fg0304.eps]

				Choose which element to go to, such as a page, from the scrolling list on the left side of the dialog box. Then type the relevant information, such as a page number, in the box on the right side of the dialog box. Click the Go To button to go to that location.

				For example, type 14 in the box and press Enter, and you go to page 14 — if you have a page 14 to go to.

				You can also summon the Go To command by clicking the page number on the status bar.

				[image: technicalstuff.eps] Note that you can go to a page relative to the current page. For example, to go three pages forward, choose Page and type +3. To go 12 pages backward, type -12 in the box.

			

		

	
		
			
				Chapter 4

				Text Editing

				In This Chapter

				Deleting characters with Backspace and Delete

				Deleting lines, sentences, paragraphs, and pages

				Splitting and joining paragraphs

				Undoing your mistakes

				Using the Redo (Undo-Undo) command

				I believe that writing involves two parts of your brain: The wild, creative  burst part is the typing part. Then there’s the tame, controlled editing part. You need both parts in order to write anything good. In fact, I’d wager that people who become frustrated with writing are too quick to enter the controlled editing part. Don’t fall into that trap: Write! Spew forth your words! Editing your text is easier when you have lots of words than when you have only a scant few.

				When you’re ready to edit, you’ll use Word’s text editing commands. They all basically delete the stuff you’ve written. That’s right: Editing text is basically the same task as ruthlessly slashing away words from your text. Word comes with ample tools to make that happen. Use them freely, as described in this chapter. But get your abundance of words down on paper before you enter the vicious slashing mode.

				Remove Text You Don’t Want

				Credit the guy who put the eraser on the end of the pencil: It’s a given that human beings make mistakes. The round, soft eraser counterbalances the sharp point of the pencil in more ways than one.

				The ability to erase text is just as valuable and necessary as the ability to create text. Deleting text is part of writing text, part of thinking and rethinking, and part of self-editing. Writing. Deleting. Rewriting. Redeleting. That’s how it goes!

				Both creating and destroying text are accomplished by using the computer keyboard. The majority of keys are used to create text. Only two keys delete text: Backspace and Delete. How these keys work, and how much of your text they can delete, depends on how the keys are used, as described in this section.

				Deleting single characters

				By themselves, the Backspace and Delete keys are used to delete single characters:

				Backspace key: Deletes the character to the left of the insertion pointer

				Delete key: Deletes the character to the right of the insertion pointer

				In the following example, the insertion pointer is “flashing” (okay, it would be flashing on a computer screen) between the h and the a in that. Pressing the Backspace key deletes the h; pressing the Delete key deletes the a.

				 Bob proudly announced th|at he feels safe enough in his neighborhood to leave his home unlocked, but he added that his neighbor has nicer stuff.

				After you delete a character, any text to the right or below the character shuffles over to fill the void.

				You can press and hold Backspace or Delete to continuously “machine-gun-delete” characters. Release the key to halt such wanton destruction, although I recommend using other delete commands (covered in this chapter) rather than the machine-gun approach.

				[image: technicalstuff.eps] Special types of text in Word cannot easily be deleted using either the Backspace or Delete key. An example is an updating text field, which holds special text that always shows, say, today’s date. This type of text appears shaded in a light gray color when you try to delete it. That’s Word reminding you of the unusualness of the text. Press the Delete or Backspace key again to delete such text.

				Deleting a word

				To gobble up an entire word, add the Ctrl key to the Backspace or Delete key’s destructive power:

				Ctrl+Backspace deletes the word in front (to the left) of the insertion pointer.

				Ctrl+Delete deletes the word behind (to the right) of the insertion pointer.

				These keyboard shortcuts work best when the insertion pointer is at the start or end of a word. When you’re in the middle of the word, the commands delete only from that middle point to the start or end of the word.

				After you delete a word, the insertion pointer sits at the end of the preceding word (or paragraph) when you use Ctrl+Backspace. Deleting a word by using Ctrl+Delete puts the cursor at the beginning of the next word. This is done to facilitate the rapid deletion of several words in a row.

				After deleting the text, Word neatly wraps up the remaining text, snuggling it together in a grammatically proper way; deleting a word doesn’t leave a “hole” in your text.

				No mere pencil eraser can match Ctrl+Delete or Ctrl+Backspace for sheer speed and terror!

				Deleting more than a word

				Beyond deleting a word or character, Word lacks keyboard-specific commands to delete lines or paragraphs of text. Word has ways to delete these things — those ways just aren’t obvious. Before the details come some definitions:

				A line of text is merely a line across the page (not really a grammatical issue).

				A sentence is a sentence. You know: Start with a capital letter and end with a period, a question mark, or an exclamation point. You probably learned this concept in grammar school, which is why they call it grammar school anyway.

				A paragraph is one or more sentences, or a heading, ending with a press of the Enter key.

				A page of text is just that — all the text from where the page starts to where the page ends.

				Word can also delete odd-size chunks of text by marking that text as a block. Refer to Chapter 6 for more information on blocks of text.

				Deleting a line of text

				The easiest way to delete a line of text is to use the mouse:

				[image: 487723-ma008.tif] 1. Move the mouse into the left margin of your document.

				 You know you’ve found the sweet spot when the mouse pointer changes into a northeast arrow.

				 2. Point the mouse pointer arrow at the line of text you want to obliterate.

				 3. Click the mouse.

				 The line of text is highlighted, or selected.

				 4. Press the Delete key to send that line into oblivion.

				Deleting a sentence

				Making a sentence go bye-bye is cinchy:

				 1. Point the mouse at the offending sentence.

				 2. Press and hold the Ctrl key and click the mouse.

				 The sentence is selected.

				 3. Press the Delete key.

				 Oomph! It’s gone.

				Deleting a paragraph

				Here’s the fastest way to delete a full paragraph:

				 1. Point the mouse at the paragraph.

				 2. Click the mouse button thrice.

				Thrice means “three times.”

				 3. Press the Delete key.

				If clicking thrice is befuddling you, move the mouse pointer into the left margin next to the offending paragraph. When the mouse pointer changes to a northeasterly-pointing arrow, click twice. That action selects the entire paragraph, which you can now whack by pressing the Delete key.

				Deleting a page

				Pages aren’t things that Word deals with offhand. In fact, pages are a printer issue. Even so, to delete a page, mind these steps:

				 1. Press Ctrl+G to summon the Go To tab in the Find and Replace dialog box.

				 See Chapter 3 for more information on the Go To command.

				 2. Type the number of the page you want to delete.

				 3. Click the Close button to dismiss the Go To dialog box.

				 4. Press the F8 key.

				 The F8 key is used to enter a special selection mode in Word, which I cover in detail in Chapter 6.

				 5. Press Ctrl+G.

				 Once again, the Find and Replace dialog box appears, with the Go To tab ready for action.

				 6. Type the next page number.

				 If you’re deleting page 6, for example, type 7.

				 7. Press Enter.

				 The entire page is now selected.

				 8. Press the Delete key.

				The page is gone.

				Refer to Chapter 9 for special information on deleting that annoying extra blank page at the end of your document.

				Split and Join Paragraphs

				For some people, a paragraph in a word processor is a strange thing. It’s basically a chunk of text. Like most things that come in chunks — cheese, meat, large men named Floyd — it’s often necessary to split or combine them. Well, maybe not for Floyd.

				Making two paragraphs from one

				[image: tip.eps] To split a single paragraph in twain, locate the point where you want them to break — say, between two sentences. Move the insertion pointer to that location and then press the Enter key. Word splits the paragraph in two; the text above the insertion pointer becomes its own paragraph, and the text following it then becomes the next paragraph.

				Depending on where you placed the insertion pointer, you may need to delete an extra space at the beginning of the second paragraph or at the end of the first paragraph.

				Making one paragraph from two

				To join two paragraphs and turn them into one, you delete the Enter character between the paragraphs. To do that, move the insertion pointer to the start of the second paragraph and then press the Backspace key. Removing the Enter character joins two paragraphs.

				Depending on how neatly the paragraphs were joined, you may need to add a space between the sentences at the spot where the paragraphs were glued together.

				The Soft and Hard Returns

				Pressing the Enter key in Word ends a paragraph. It’s officially known as typing a hard return. Yes, it’s return even though the key is known as Enter on a PC. Don’t blame me for this odd nomenclature. I only write the books — not the programs.

				The problem with the hard return is that it adds a bit of “air” after a paragraph. That’s a good thing; as I explain in Chapter 11, you should have air around paragraphs in a document. Those times when you don’t want air, when you need to put lines of text close together, you use a soft return.

				The soft return, or line break, is used primarily in titles and headings; when you have a long title and need to split it up between two lines, you press Shift+Enter to insert the soft return. For example, type this line:

				Enjoying the Ballet

				Press Shift+Enter. A new line starts. Continue typing:

				A Guide for Husbands and Boyfriends

				The soft return keeps the title text together (in the same paragraph), but on separate lines.

				[image: tip.eps] You should also use the soft return when typing an address, either on an envelope or in a letter. Press Shift+Enter after typing each of these lines:

				Mr. President

				1600 Pennsylvania Ave.

				Washington, DC 20500

				If you try typing the same text and press Enter instead, you see more space between the lines, which isn’t what you want. Nope, that soft return can sure come in handy.

				Undo Mistakes with Undo Haste

				That quaffing and drinking will undo you.

				— Richard II, William Shakespeare

				The Undo command undoes anything you do in Word, which includes formatting text, moving blocks, typing and deleting text, formatting — the whole quesadilla. You have two handy ways to unleash the Undo command:

				Press Ctrl+Z.

				Click the Undo command button on the Quick Access Toolbar.

				[image: 487723-ma015.tif] I prefer using the Ctrl+Z key combination, but an advantage of the Undo command button is that it sports a drop-down menu that helps you review the past several things you’ve done, or that can be undone.

				Word’s Undo command is handy, but don’t use it as an excuse to be sloppy!

				Regrettably, you cannot pick and choose from the Undo command button’s drop-down menu; you can merely undo multiple instances of things all at one time.

				Undo works sporadically sometimes. Before this happens, Word warns you. For example, you may see a message such as “There is not enough memory to undo this operation, Continue?” Proceed at your own peril.

				The Undo command doesn’t work when there’s nothing to undo or if something just cannot be undone. For example, you cannot undo a save-to-disk operation.

				To undo an Undo, choose Redo. See the next section.

				Redo, the Undo-Undo command

				If you undo something and — whoops! — you didn’t mean to, you must use the Redo command to set things back to the way they were. For example, you may type some text and then use Undo to “untype” the text. You can use the Redo command to restore the typing. You have two choices:

				Press Ctrl+Y.

				Click the Redo command button on the Quick Access Toolbar.

				[image: 487723-ma016.tif] The Redo command does exactly the opposite of whatever the Undo command does. So, if you type text, Undo untypes the text and Redo recovers the text. If you use Undo to recover deleted text, Redo deletes the text again.

				Redo, the Repeat Typing command

				[image: 487723-ma017.tif] When the Redo command has nothing left to redo, it changes functions and becomes the Repeat Typing command. Boy, can the Repeat Typing command be a timesaver!

				For example, type these lines in Word:

				Knock, knock.

				Who’s there?

				Knock.

				Knock who?

				Now press Ctrl+Y or choose the Repeat Typing command button from the Quick Access Toolbar. Word repeats the last few things you typed. (If you had to press the Backspace key to back up and erase, Ctrl+Y repeats only from that point on.)

				[image: tip.eps] The Repeat Typing command can also used to reapply formatting. When you’re working through a document and changing styles on various chunks of text, using the Repeat key or Redo command can save oodles of time, especially in applying formatting. (See Part III of this book for information on formatting.)
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